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RZ/G2L, G2LC, G2UL
Quick Start Guide for RZ/G2L, G2LC, G2UL Multi-OS Package

Introduction

This document outlines the procedure for integrating the RZ/G Multi-OS Package into the RZ/G Verified
Linux Package (referred to as VLP) for the RZ/G2L, RZ/G2LC and RZ/G2UL. By integrating the Multi-OS
Package, users can efficiently establish a Multi-OS environment wherein Linux operates on the Cortex®-A55
and FreeRTOS/BareMetal runs on the Cortex-M33, with support for Inter-Processor Communication between
these CPU cores.

This package requires the RZ/G Flexible Software Package (FSP) for an RTOS/BareMetal environment. The
figure below illustrates the software stack for integrating the RZ/G Multi-OS Package with the RZ/G2L,
RZ/G2LC and RZ/G2UL:

RZ/G Multi-OS Package

RZ MPU Verified Linux Package [6.1-CIP] RZ/G Flexible Software Package

HAL Driver
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RZ/G Series

Here are brief descriptions of each component included in RZ/G Multi-OS Package:

e RZ/GFSP
This software package consists of production ready peripheral drivers, FreeRTOS and portable
middleware stacks and best in-case HAL drivers with low memory footprint.

e OpenAMP
The framework includes the software components required for Asymmetric Multiprocessing (AMP)
systems, such as Inter-Processor Communication.

Target Device

RZ/G2L
RZ/G2LC
RZ/G2UL
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1. Specifications
Table 1-1 lists the on-chip peripheral modules to be used in this package.

Table 1-1 Peripheral modules to be used in this package

Peripheral module Usage

Message Handling Unit (MHU) Configure Inter-Processor Interrupt.

Serial Communications Interface with FIFO (SCIFA) | Perform standard serial communications sending
and receiving console messages.

Interrupt controller (INTC) Handle the following types of interrupts as shown

below for example:

e Processors should receive interrupts during
buffered serial communications.

e MHU module fires Inter-Processor Interrupt.

General Purpose Input Output (GPIO) Configure 1/0O lines used by serial communications.

General Timer (GTM) Configure the tick for FreeRTOS.

2. Verified Operation Conditions
Table 2-1 shows the verified operation conditions.

Table 2-1 Verified Operation Conditions

Item Contents

Integrated Development Environment e? studio 2025-07 or later

Toolchain GNU Arm Toolchain 13.3.Rel1 AArch32 bare-metal
target (arm-none-eabi)

Dependent Software e RZ/G Flexible Software Package (FSP) v3.1.0
e RZ/G Verified Linux Package v3.0.7
e RZ MPU Verified Linux Package v4.0.1

3. Sample Program Setup

3.1 Flexible Software Package Setup

Multi-OS Package expects RZ/G Flexible Software Package (FSP) to be installed in advance. For details on
the installation, please refer to Getting Started with Flexible Software Package.

3.2 Integration of OpenAMP related stuff

3.21 Using RZ MPU VLP v4.0.1

This section describes how to integrate OpenAMP related stuff to RZ MPU Verified Linux Package [6.1-CIP]
(hereinafter referred to as VLP). The steps are based on RZ/G2L and RZ/G2LC-EVKIT Linux Start-up
Guide (hereinafter referred to as Linux Start-up Guide) included in RZ MPU VLP v4.0.1.

1. Follow the procedure stated from the beginning of 2.2 Building Images to (4) Add layers of Linux Start-
up Guide.

2. Download Multi-OS Package (r01an5869ej0310-rzg-multi-os-pkg.zip) to a working directory and run the
RZ MPU VLP v4.0.1

$ cd ~/rzg vlp <pkg ver>
$ unzip <Multi-0S Dir>/r01an5869ej0310-rzg-multi-os-pkg.zip
$ tar zxvf r0lan5869ej0310-rzg-multi-os-pkg/meta-rz-features multi-os v3.1.0.tar.gz
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Here, <pkg_ver> and <Multi-OS Dir> indicate the version number of VLP (e.g. v4.0.1) and the path to the
directory where Multi-OS Package is placed respectively.

3. Add the layer for Multi-OS Package.

$ cd build
$ bitbake-layers add-layer ../meta-rz-features/meta-rz-multi-os/meta-rzg2l-vlp4

(Optional for remoteproc support)

4. Uncomment the following lines stated in meta-rz-features/meta-rz-multi-os/meta-rzg2l-
vipd/conf/layer.conf for enabling remoteproc support:

MACHINE FEATURES:append = " CM33 REMOTEPROC"

5. Start a build as described in (6) Start a build of 2.2 Building Images as shown below:

$ MACHINE=<board> bitbake core-mage-<target>

For details on the allowable value of <board> and <target>, please refer to Linux Start-up Guide.

3.2.2 Using RZ/G VLP v3.0.7

This section describes how to integrate OpenAMP related stuff to RZ/G Verified Linux Package [5.1-CIP]
(hereinafter referred to as VLP). The steps are based on RZ/G2L, RZ/G2LC and RZ/G2UL-EVKIT Linux
Start-up Guide (hereinafter referred to as Linux Start-up Guide) included in RZ/G VLP v3.0.7.

1. Follow the procedure stated from the beginning of 2.2 Building Images to (4) Add layers of Linux Start-
up Guide.

2. Download Multi-OS Package (r01an5869ej0310-rzg-multi-os-pkg.zip) to a working directory and run the
commands stated below:

$ cd ~/rzg vlp <pkg ver>
$ unzip <Multi-O0S Dir>/r01an5869ej0310-rzg-multi-os-pkg.zip
S tar zxvf r0lan5869ej0310-rzg-multi-os-pkg/meta-rz-features multi-os v3.1.0.tar.gz

Here, <pkg_ver> and <Multi-OS Dir> indicate the version number of VLP (e.g. v3.0.7) and the path to the
directory where Multi-OS Package is placed respectively.

3. Add the layer for Multi-OS Package.

$ cd build
$ bitbake-layers add-layer ../meta-rz-features/meta-rz-multi-os/meta-rzg2l-vl1p3

(Optional for remoteproc support)

4. Apply the medication stated below to meta-rz-features/meta-rz-multi-os/meta-rzg2I-vip3/recipes-
kernel/linux/linux-renesas_5.10.bbappend for enabling remoteproc support:

FILESEXTRAPATHS prepend := "${THISDIR}/${PN}:"
ENABLE REMOTEPROC = "1"

5. Start a build as described in (6) Start a build of 2.2 Building Images as shown below:

$ MACHINE=<board> bitbake core-image-<target>

For details on the allowable value of <board> and <target>, please refer to Linux Start-up Guide.
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3.3 Note for integration

On RZ/G Linux, the peripherals which are NOT enabled enter Module Standby Mode after Linux kernel is
booted up. That means the peripherals used on CM33 side might stop working after that. To avoid such a
situation, Multi-OS package incorporates the patch listed below:

3.3.1 For RZ/G2L, RZ/G2LC
e 0006-clk-renesas-r9a07g044-Set-SCIF1-SCIF2-OSTM2.patch

This patch prevents SCIF channel1, SCIF channel 2 and GTM channel 2 used in RPMsg demo program
from entering Module Standby Mode. If you have any other peripherals which you would like to stop entering
Module Standby implicitly, please apply the patch as shown below:

drivers/clk/renesas/r9a07g044-cpg.c | 3 +++
1 file changed, 3 insertions (+)

diff --git a/drivers/clk/renesas/r9a07g044-cpg.c

b/drivers/clk/renesas/r9a07g044-cpg.c

index e27caal75af7a..£f3cda2e05757f 100644

-—-- a/drivers/clk/renesas/r9a07g044-cpg.c

+++ b/drivers/clk/renesas/r9%9a07g044-cpg.c

@@ -449,6 +449,9 @@ static const unsigned int r9%a07g044 crit mod clks[]

__initconst = {

MOD CLK BASE + R9AO7GO44_IA55_PCLK,

MOD CLK BASE + R9AO7GO44_IA55_CLK,

MOD CLK BASE + R9AO7GO44_DMAC_ACLK,
MOD CLK BASE + R9AO7GO44_SCIF2_CLK_PCK,
MOD CLK BASE + R9AO7GO44_OSTM2_PCLK,
MOD CLK BASE + R9AO7GO44_SCIF1_CLK_PCK,
MOD CLK BASE + ROA07G044 xxxx,

+ o+ o+ o+

}i

With respect to the allowable value for xxxx, please refer to the link below:

e https://github.com/renesas-rz/rz_linux-
cip/blob/f12a03d8f2cf971734190c35aeaac98dde815b2d/drivers/clk/renesas/r9a079044-cpg.c#L244-1.412

3.3.2 For RZ/G2UL
e 0008-clk-renesas-r9a07g043-Set-OSTM2.patch

This patch prevents GTM channel 2 used in RPMsg demo program from entering Module Standby Mode. If
you have any other peripherals which you would like to stop entering Module Standby implicitly, please apply
the patch as shown below:

drivers/clk/renesas/r9a07g043-cpg.c | 1 +
1 file changed, 1 insertion (+)

diff --git a/drivers/clk/renesas/r9a07g043-cpg.c
b/drivers/clk/renesas/r9a07g043-cpg.c

index dad498elb0693..296923ad08f1f 100644

--- a/drivers/clk/renesas/r9a07g043-cpg.c

+++ b/drivers/clk/renesas/r9%9a07g043-cpg.c

@@ -399,6 +399,7 @€ static const unsigned int r9a07g043 crit mod clks[]
__initconst = {
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MOD CLK BASE + R9A07G043 IA55 PCLK,
MOD CLK BASE + R9A07G043 IA55 CLK,
MOD CLK BASE + R9A07G043 DMAC ACLK,
+ MOD CLK BASE + R9A07G043 OSTM2 PCLK,
+ MOD CLK BASE + R9A07G043 xxxx,
bi
With respect to the allowable value for xxxx, please refer to the link below:

e https://qithub.com/renesas-rz/rz_linux-
cip/blob/f12a03d8f2cf971734190c35aeaac98dde815b2d/drivers/clk/renesas/r9a079043-cpg.c#L165-L.308

3.4 Deployment of RZ/G VLP

With respect to the deployment of Linux kernel, device tree and root filesystem for RZ/G2L, R/G2LC and
RZ/G2UL, please refer to Linux Start-up Guide.

4. Sample Program Invocation on RZ/G2L SMARC EVK

4.1 Hardware Setup

1. Connect SEGGER J-Link to RZ/G2L SMARC EVK. For details, please refer to Getting Started with
Flexible Software Package.

2. Connect Pmod USBUART to the upper side of Pmod 1 of SMARC Carrier Board as shown below for
securing the console for the program running on CM33.

el

-
-

Figure 4-1. Connection between RZ/G2L SMARC EVK and Pmod USBUART

Note: There is no valid SCIF channel connected to Pmod 0 or Pmod 1 on RZ/G2UL Smarc EVK
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4.2 CM33 sample project Setup
This section describes how to set up CM33 sample project.

1. Extract r01an5869ej0310-rzg-multi-os-pkg.zip on your development PC.

2. Extract rzg2l_cm33_rpmsg_linux-rtos_demo.zip included in the unzipped r01an5869ej0310-rzg-multi-

os-pkg.zip.
3. Open e? studio 2025-07 and click File > Import.

4. Double-click General and select Existing Projects into Workspace as shown in Figure 4-2:

B impent |
Salect -

|
Creabe Feive projicts Irorm o archive e or dnecharng. Fr' J

Gebeck s ot wizend:

w (= Garmral
JE Archosa Film
o CHEIS Pack
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4 File Systerm
& GHUARM-HOMEFRIDE- Y propect convessasn 1o GOC ARM Esvbedded
1 Paelerences
3 Poogects from Folder or Sachive
= Rename & Import Existing £/C+ = Propert inbs Workspace
T Reneses Ui Projecd foe CATIKORACATIED
T Peneses {5 Project foe CC-RE and CC-RL
T Reneses GitHub FreelTOS (with IoT librenes) Project
¢ Serrple Projects on Aeness Websie
= G+
e e Conrmrabics

Figure 4-2. Import sample project (1)

5. Input the path to the directory rzg2l_cm33_rpmsg_linux-rtos_demo, press Enter key and click Finish

button.
I [- R O % |
Irepart Projet
L e L e i

T - R
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Figure 4-3. Import sample project (2)
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(Optional for configuring RPMsg channel)

6. By default, RPMsg channel 0 is configured to be used on CM33. If you would like to use channel 1,
please open the property of MainTask#0 on FSP Smart Configurator, specify 1 for Thread Context, and
push General Project Content button. If Generate Project Content pop-up is shown, click Proceed to
reflect the change to the source code.

Stacks Configuration

Generate Project Content

&) NewThread 5] Remove = MainTask#0 Stacks &) New Stack >

o Add stacks to the selected thread by using the New Stack' toolbar button (above), or by pasting here from the clipboard

> 8 Generate Project Content X

Objects 4] New Object >
B i 2 Configuration must be saved before generating project content.

} Proceed with save and generate?

[ Always save and generate without asking

Proceed Cancel
Summary [BSP | Clocks | Pins [Interupts Stacks| Components

(22 Problems | & Console |[T] Properties X | @ Smart Browser| & Smart Manual

MainTask#0

Value

Allocate Secure Context

Figure 4-4. RPMsg Channel Setting

(Optional for remoteproc support)
7. Change the value for ENABLE_REMOTEPROC defined in platform_info.h from 0 to 1 as shown below:

#define ENABLE REMOTEPROC (1U)

8. Build the project from Choose Project > Build Project.
9. The following files should be generated in Debug and/or Release directory in accordance with the active
Build Configuration if there is no build failures.
e rzg2l_ cm33_rpmsg_linux-rtos_demo.elf
e rzg2l_ cm33_rpmsg_linux-rtos_demo_non_secure_code.bin
e rzg2l_cm33_rpmsg_linux-rtos_demo_non_secure_vector.bin
e rzg2l_cm33_rpmsg_linux-rtos_demo_secure_code.bin
e rzg2l_cm33_rpmsg_linux-rtos_demo_secure_vector.bin
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4.3 CM33 sample program invocation

4.3.1 CM33 sample program invocation with SEGGER J-Link
You need to follow the steps stated below to invoke CM33 sample program with SEGGER J-Link:

1. Choose rzg2l_cm33_rpmsg_linux-rtos_demo Debug_Flat or rzg2l_cm33_rpmsg_linux-rtos_demo
Release_Flat from the drop-down list indicated by a red arrow in Figure 4-4.

Q 3_project - e studio
File Source Refactor Navigate Search Project Renesas Views Run Window Help

4 ® | | % Debug E7 rzv2l_cm33_rpmsg_der > v v@idsia

B - - - -

% .

Launch in ‘Debug’ mode

" Project Explorer x

v 5 rzv2l_ecm33_rpmsg_demo [Del
# Binaries

2 Includes

Figure 4-5. Selection of Debug Configuration

2. Click the debug button indicated by a red arrow as shown below:

& worllbL - ¢ studio
File E Navigate Search Project RenesasViews Run Window Help

|

e ! Launch in 'Debug’ mode
;’I & =

15 Debug 3 k| 8 = O

[e7] rzg2l_cm33_rpmsg_demo Debug_F

=] 2 -|

Figure 4-6. Debug Function Launch

If Confirm Perspective Switch window below appears, press Switch to go ahead.

& Confirm Perspective Switch X
| This kind of launch is configured to open the Debug perspective when it suspends.
This Debug perspective supports application debugging by providing views for
displaying the debug stack, variables and breakpoints.

Switch to this perspective?

[J Remember my decision

Figure 4-7. Confirm Perspective Switch window
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3. When Debug Perspective is opened, Program Counter (PC) should be located at the top of
Warm_Reset_S function. Then, you need to press the button indicated by a red arrow in Figure 4-7.

@ CM33 project 1633 - rzv2l_cm33_rpmsg_dema/rzv/Fsp/sec/bsp/cmsis/ Device/RENESAS/ Source/systilill - ¢ studio
Fle Edit Source Refactor Navigate Search Project Renesas Views Bun Window Help

= Warm Reset S0 at systems.c147 Ox72eff584 19 72eff554
o arm-none-eabi-gdb (18.2) o

4 Renesas GDB server (Host,

main stack pointer t
__set_MSP(BSP_PRV_SECURE_STACK_TOP);
* Use CM33 stack monito .
—set_MSPLIM(BSP_PRV_SECURE_STACK_LIMIT);
* Initialize security features
T2e££564 R_BSP_SecurityInit();

alize trigger NVIC interrupt

* Initial 88
bsp_irg_cfg_s();

l_!ép;ﬂoni;curlihtlf( %

* In the Cortex-M33 CPU core of this device
_attribute__((optimize("-017))) void Warm_R
{
<

s (void)

* CM33 reset *
R_BSP_NVIC_CM33_RESET();

* Wait CM33 reset *
150 72eFF592 R_BSP_WAIT_CM33_RESET();

* Disable IM33
R_BSP_IM33_DISABLE();

12v2| om33 1pmsg_demo Debug_Flat [Renesas GOB Hardware Debugging]
P

GD8: 51828

B-Aob IBERIER - OK

O ASTEL 20x600112¢ LT LAY,

Writable

4/ % 8] ®Debug T rzv2l om33_rpmsg_der =R ~-ﬂ'-\-B L i LIR R A RAL B A T
© Debug i 3 [rzv2! pmsg_demo] FSP Configuration m
» [ r2v2l cm33 rpmsg demo Debug Flat Renesas GDB He| 11> /2 v undi:"‘umﬂ = THRDLTY S_SSIRLWErs;
~ @ rzv2| cm33_spmsg_demo.elf [1] [cores: 0]
* & Thread #1 1 (single core) [core: O] (Suspended : 5| 118 * Conf system clocks
bsp_clock_init();

o BSP_PRV_SECURE_STACK TO

@Console * = Registers @ Debug Shell ! Problems @ A7-F-739Y~ @Debugger Console 0 Memory

- o X
Tl LT vilw vowlm
QW+ ©Debug
Va % "B SMo GPr WEx &4 Pe EI g
Name Type Vaive
sRvEE o~
>
Sma_ert

Figure 4-8. How to start to debug sample project (1)

4. Program stops at the top of main function. So, please click the same button as the previous step.

& OM23_project_1633 - rzv2l_cm33_rpmsg_demo/rzv_gen/main.c - & studio - [m] X
flle Edit Source Refactor Navigate Search Project RenesasViews Run Window Help
%|/e| = ©Debug 1 rzv2l_cm33_rpmsg der o ~vs--\~ans ST X evav o ™ Tl
e vovd Q oW+ BDebug
© Debug * = frzv21_cm33 _rpmsg_demo] FSP Configuration (@ systems.c V X %Br mM &P HE @4 RP I
v Eav2l em33 rpmsg_demo Debug_Flat [Renesas GI| 94 } .
v @ rzv2l_em33_rpmsg_demo.elf [1] [cores: O] res inl = . Name Type Value
v & Thread 81 1 fsingle core) fcore: 0] (Suspend | static inline uint32_t _TOR32(uintptr_t adr)
= main{) at main.c103 0x600112c2 return *(volatile uint32_t*) adr;
o arm-nane-eabi-gdb (7.8.2) }
o Renesas GDB server (Host)
int main(void)
8_fsp_common_thread_count = @;
8_fsp_common_initialized = false;
#if (configSUPPORT_DYNAMIC_ALLOCATION)
* Define Heap reagion (this is used ¢
vPortDefineHeapRegions (xHeapRegions);
sendif
* Create semaphore to make sure common init is don
8_fsp_common_initialized_semaphore
#if configSUPPORT_STATIC_ALLOCATION
xSemaphoreCreateCountingStatic (
relse
xSemaphoreCreateCounting (
#endif
1 256,
" 1
1 #1f configSUPPORT_STATIC_ALLOCATION
» &g_fsp_common_initialized_semaph
< o < >
O Console * i Registers [ Debug Shell ¥ Problems & 27-b-75%9%- @ Debugger Console 0 Memory - » SN0 vO~
rzv2| em33 pmsg_demo Debug Flat [Renesas GDB Hardware Debugging]
-k R T i
GDB: 51828
B-NohERIER - 0K
B-oMERIER - OK
S0 Bk
FNO-ERT v
< > < >
Writable Smart Insert 1.0

Figure 4-9. How to start to debug sample project (2)
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5. Now that CM33 sample project has started, the following message is shown on the console associated
with Pmod USBUART:

Successfully
Successfully
Successfully
Successfully
Successfully
Successfully
Successfully

probed IPI device

open uio device: 42F00000.rsctbl.

added memory device 42F00000.rsctbl.
open uio device: 43000000.vring-ctlO.
added memory device 43000000.vring-ctlO.
open uio device: 43200000.vring-shmO.
added memory device 43200000.vring-shm0.

Initialize remoteproc successfully.
creating remoteproc virtio

initializing

rpmsg vdewv

Please note that CM33 sample program is waiting for the establishment of RPMsg channel between
CM33 and CA55.

Note: There is no valid SCIF channel connected to Pmod 0 or Pmod 1 on RZ/G2UL SMARC EVK and so,
any message won'’t be shown with RZ/G2UL.

4.3.2 CM33 sample program invocation with u-boot
You can invoke CM33 sample program from u-boot by following the procedure described below:

1.
2
3.
4. Hit any key to stop autoboot within 3 seconds after the following message is shown in the console

Copy the binary files generated at 8 of section 4.2 to microSD card.

. Insert the microSD card into CN10 of SMARC Carrier Board.

Turn on SMARC EVK by pressing the Power button for a few seconds.

connected to CN14 of SMRAC Carrier Board:

U-Boot 2024.07 (Sep 22 2025 - 10:51:32 +0000)

CPU: Renesas Electronics CPU rev 1.0

Model: smarc-

rzgzl

DRAM: 1.9 GiB

WDT : watchdog@0000000012800800

WDT : Started with servicing (60s timeout)
MMC : sd@11c00000: 0, sd@11lcl0000: 1
Loading Environment from MMC... OK

In: serial@1004b800

Out: serial@1004b800

Err: serial@1004b800

U-boot WDT started!

Net: ethO:

ethernet@11c20000

Hit any key to stop autoboot: 2

=>
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5. Load the binary files you copied at step1 from microSD card to RAM by executing the commands stated
below on the console. Here, N stands for the partition number in which you stored the binary files.

dcache off
mmc dev 1

fatload mmc

fatload mmc

fatload mmc

fatload mmc
cm33 start debug 0x1001FF80 0x00010000
dcache on

N Ox0001FF80 rzg2l cm33 rpmsg linux-rtos_demo_ secure vector.bin

:N O0x42EFF440 rzg2l cm33 rpmsg linux-rtos demo_secure_ code.bin

N 0x00010000 rzg2l cm33 rpmsg linux-rtos_demo non_secure vector.bin
1:N 0x40010000 rzg2l cm33 rpmsg linux-rtos_demo non_secure code.bin

o

6. CM33 sample program is now started.

4.3.3 CM33 sample program invocation with remoteproc
Here is the procedure for invoking CM33 sample program with remoteproc:
1. Booting up Linux by following 5. Booting and Running Linux of SMARC EVK of RZ/G2L Linux Start-

up Guide.
2. Invoke the command stated below to specify the sample program to be loaded:

root@smarc-rzg2l:~# echo rzg2l cm33 rpmsg linux-rtos demo.elf >
/sys/class/remoteproc/remoteprocO/firmware

3. Kick CM33 by invoking the command below:

root@smarc-rzg2l:~# echo start > /sys/class/remoteproc/remoteproc(O/state

If CM33 sample program starts to work successfully, the following message should be shown on Linux
console:

root@smarc-rzg2l:~# echo start > /sys/class/remoteproc/remoteprocO/state

[ 737.
[ 737.
[ 737.
[ 737.
[ 737.
[ 737.

289773]
3482261
3567321
366255]
3747841
3809891

remoteprocremoteproc(O: powering up cm33

remoteprocremoteprocO: Booting fwimage rzg2l cm33_ rpmsg_linux-rtos_demo.elf, size 1347660
remoteprocremoteprocO: unsupported resource 4

remoteprocO#vdevObuffer: assigned reserved memory node vdevObuffer@0x43200000
remoteprocO#vdevObuffer: registered virtioO (type 7)

remoteprocremoteprocO: remote processor cm33 is now up
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4.4 CAS55 sample program invocation
This section describes how to invoke CA55 sample program.

1. Boot up Linux by executing the following command on u-boot:

=> run bootcmd

2. Login as root.

smarc-rzg2l login: root

3. Run CA55 sample program by executing the following command:
root@smarc-rzg2l:~# rpmsg sample client

4. Then, you can see the following message on the console relative to CN14 of SMARC carrier board. Be
sure that you invoke CM33 sample program in advance.

Successfully
metal: info:
Successfully
Successfully
metal: info:
Successfully
Successfully
metal: info:
Successfully
Successfully
metal: info:
Successfully
Successfully
metal: info:
Successfully
Successfully
metal: info:
Successfully
Successfully

probed IPI device
metal uio dev open: No IRQ for device
open uio device: 42f00000.rsctbl.
added memory device 42f00000.rsctbl.
metal uio dev open: No IRQ for device
open uio device: 43000000.vring-ctlO.
added memory device 43000000.vring-ctlO.
metal uio dev open: No IRQ for device
open uio device: 43200000.vring-shmO.
added memory device 43200000.vring-shmO.
metal uio dev open: No IRQ for device
open uio device: 43100000.vring-ctll.
added memory device 43100000.vring-ctll.
metal uio dev open: No IRQ for device
open uio device: 43500000.vring-shml.
added memory device 43500000.vring-shml.
metal uio dev open: No IRQ for device
open uio device: 42f01000.mhu-shm.
added memory device 42f01000.mhu-shm.

42f00000.rsctbl.

43000000.vring-ctlO0.

43200000.vring-shmO.

43100000.vring-ctll.

43500000.vring-shml.

42f01000.mhu-shm.

Initialize remoteproc successfully.
Initialize remoteproc successfully.

KAAKRAAIAARA KA XA AR A AR I AR I AR A AR A AR A AR A AR A A h kA kK

* rpmsg communication sample program *
KAk AR A AR A A KNI AR A AR A A AR A A A AR hA A A A A A A A A A Kk

1. communicate with RZ/G2L CM33 chO
2. communicate with RZ/G2L CM33 chl

e. exit

please input
>

5. Type 1 if RPMsg channel 0 is used on CM33 RPMsg sample program. Also, type 2 if RPMsg channel 1 is
used on the sample program.
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4.5 Overview of sample program behavior
The behavior of sample program is stated below:

1. Wait until a communication channel between CA55 and CM33 is established.

2. Once the communication channel is established, CA55 sample program starts to send the message to
CM33 by incrementing its size from the minimum value 17 to the maximum value 488. When sending the
message, the following log should be shown on Linux console:

Sending payload number 148 of size 165

3. When CM33 receives the message sent from CA55, the echo reply is sent back to CA55.
4. When CAD5S5 receives the echo reply, the message below should be displayed in the console:

echo test: sent : 165
received payload number 148 of size 165

5. After the message which has 488 bytes sized payload is sent from CA55 to CM33 and CM33 sends back
the echo reply, the message for terminating the communication channel is sent from CA55 to CM33.
Then, CA55 and CM33 sample programs output the following log messages to the corresponding
consoles respectively when receiving the termination message.

e On CA5S side:

R R I i I I I I I S I I S I I I I e b A I b I I b S I b S I b Sh b b S

* rpmsg communication sample program *
R IR b b b b b b b b b a b b b b 2 b b b b b b b b b b db b d b 2 b 4 b b b b b g

1. communicate with RZ/G2L CM33 chO
2. communicate with RZ/G2L CM33 chl

e. exit

please input
>

If you would like to quit the application, please type e.
e On CM33 side:

De-initializating remoteproc

6. Finally, CM33 sample program re-waits for the establishment of connection channel. You can see the
following log on the console a short time later:

creating remoteproc virtio
initializing rpmsg vdev

5. Reference Documents

e RO01AN5924: RZ/G2L, RZ/G2LC, RZ/G2UL, RZ/G3S and RZ/G3E Getting Started with Flexible Software
Package

e RO01US0616: RZ/G2L, RZ/G2LC and RZ/G2UL-EVKIT Linux Start-up Guide

e RO1UH0964: RZ/G2L, RZ/V2L SMARC Module Board User’'s Manual

e RO1UH0966: RZ SMARC Series Carrier Board User’s Manual
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.
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1.

10.

11.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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